Table of Contents

Introduction 3

Installation 4

Post Setup Configuration 8

User Database Configuration 10

Management 15
I Introduction

The 10ZiG Manager suite offers administrators the ability to remotely manage 10ZiG XTC thin clients running Microsoft® Windows® XP Embedded operating system, as well as the means to configure 5250 emulation and connectivity for these clients. The suite comprises two primary applications, XTC Monitor and User Configuration Manager. The XTC Monitor provides the XTC thin client system management capabilities permitting the administrator perform such remote tasks as powering on and off, rebooting, updating and imaging the thin clients. The User Configuration Manager is the portal for remotely configuring 5250 connectivity and emulation settings on the thin clients per user or machine basis.

II Installation

A. If you are installing from a Zip file, extract all the files to temporary folder of your choice. Launch setup.exe from this folder to start the installation process.

B. A welcome dialog will appear. Click the Next button to proceed.
C. After reviewing the Software License Agreement, click Yes to accept and proceed.

D. In the user information dialog, enter the appropriate information and click Next to continue.
E. A dialog will ask you to choose the program group folder in which to create the 10ZiG Manager shortcuts. It is recommended to accept the default location. Click *Next* to proceed.

F. A summary dialog will appear containing the installation details. Click *Next* to start copying the program files.
G. The file copy process will require a minute or two to complete.

H. After the files have been copied, the following dialog will appear. It is unnecessary to view the Release Notes as they are superseded by this document. Click *Next* to continue.
I. Click the Finish button to complete the installation process and start the configuration phase.

III Post Setup Configuration

A. Shortly after the installation has completed, a dialog will appear to set the user database to store configurations on a user name or computer basis. Choose the Computer name option to apply emulation settings to all users on specific computers and accept the default TCP port number of 3002. If you require individual settings for each user, select the User name option. Click the OK button to proceed.
B. A temporary user database is configured and the following dialog appears briefly and will automatically hide itself after a few seconds.

C. The Configuration Server service will start along with a service Watchdog and a Log Manager utility. These programs will create the following icons in the system tray.
IV User Database Configuration

**XTC Monitor** is the primary application window for managing thin clients; however, the 10ZiG Manager suite provides the ability to manage and deploy user emulation settings for 5250 connectivity via the **User Configuration Manager**. Many thin client management tasks require certain settings to be configured for a default user group within the user database. The following details the necessary settings to get started but will not digress into the specifics of emulation configuration.

A. If the Configuration Server is not running, restart it by navigating to the **10ZiG Manager** menu within the Start menu. Select the **Start Configuration Server** item.

B. Launch the **User Configuration Manager** by right-clicking on the **Configuration Server** tray icon and selecting **User Configuration** or launch it from the Start menu.

C. A warning will appear when the **User Configuration Manager** is launched the first time stating various settings need to be configured for the “_default” user group. Click the **Yes** button to configure these settings.
D. The **TCP/IP Configurator** will be launched as pictured here
E. A Host entry needs be added for your 5250 server or set to a loopback IP address if you do not require 5250 connectivity. Click the Add button to set a default host. The following dialog will appear. Enter your 5250 server’s IP address or select the Use host DNS name option and specify a computer name into the provided field. If 5250 connectivity is not required, enter 127.0.0.1 into the IP address field for loopback. Click OK to add and return to the main configurator dialog.

F. Now it is necessary to set the default management server IP address. On the main TCP/IP Configurator dialog, select the Advanced tab.
G. From the list of **Advanced Parameters**, click the **10ZiG Manager Server** setting, which will be the default IP address used for communication with thin clients. Initially the value is undefined so a dialog will prompt to use the first available IP address for this computer. Click **Yes** if you wish to use this address or **No** to enter a different IP. Enter an address configured for this server into the **IP address** field leaving the **Port** field set to the default, **3002**. Click **OK** on the main dialog to save and exit.
H. Save settings for the "_default" group by selecting the **File** menu and clicking **Save**.

I. Once database has been saved, exit the **User Configuration Manager** from the **File** menu or click the red close button. When prompted, click **Yes** to confirm exiting.
V Management

The primary portal for managing thin clients with the **10ZiG Manager** is the **XTC Monitor**, which provides functions to reboot, power on/off, clone system configurations, push patches and deploy 5250 connectivity settings.

A. Launching XTC Monitor

**XTC Monitor** can be launched in several ways, either by left-clicking on the **Configuration Server** tray icon or right-clicking on the icon and selecting **XTC Monitor**. As well, on the Start menu from the **10ZiG Manager** sub-menu, you can select the **10ZiG XTC Monitor** item.

B. Default Network Adapter (Multiple NICs)

When starting the **XTC Monitor** the first time, a dialog is displayed prompting for the default Local Area Connection to be used if your server has multiple network adapters installed. Select the appropriate IP address from the drop-down list. After selecting an IP, the details of that connection are displayed. Click the **OK** button to accept and proceed.
C. Thin Client IP Address Range

The XTC Monitor utilizes user-specified IP address ranges to search for 10ZiG XP Embedded thin clients. At least one address range should be added.

1. Click on the **Settings** tab of the left pane which will appear as follows.
2. Click the **Add** button. Enter the first and last IP addresses of a range into the appropriate fields and click **OK** to complete the addition.

3. Click the **Start** button to search the newly created range and populate the list of thin clients in the right pane.

4. Later searches can be initiated by clicking the **Search** button on the toolbar to search all configured IP address ranges to locate any newly deployed thin clients.

D. XTC Monitor Settings

The **Settings** tab on the left pane of the **XTC Monitor** window includes a few options affecting some of the behavior of the program. These settings are all enabled by default.

1. Close this tab after search

   When enabled, this setting causes the left pane to switch back to the **Groups** tab after a thin client search has been performed.

2. Client status On-Demand
By default, **XTC Monitor** checks the thin client status when it first starts and when manually refreshed. Turn this option off to have the Monitor continually poll thin clients at a set interval.

3. **Ask for confirmation before task starting**

   This setting causes a confirmation dialog message to be displayed prior to starting thin client management tasks.

4. **Refresh Client before task starting**

   This setting configures the Monitor to automatically refresh the status of the selected thin client prior to starting client management tasks.

5. **Show Error/Warning messages**

   This setting enables the *Log* pane to be automatically displayed, if not already, when a task is initiated.

6. **Show the Exit confirmation message**

   This setting causes an exit confirmation dialog to be displayed prior to closing the Monitor.

**E. Removing Client(s) From List**

To remove a thin client from the Monitor list, select it and click the ![Remove Client](image) button. When the confirmation dialog appears, click *Yes* to remove the client.

**F. Ownership**

In order to perform the most management tasks on thin clients via the **XTC Monitor**, the current server must “take ownership” of those clients, which simply sets the default management server IP address for the clients.

1. **Right-click on an individual thin client or select multiple clients by holding down the Ctrl button and left-clicking on additional clients. Then click on the toolbar button or right-click on a selected client and choose *Take Ownership* from the menu.**
2. A dialog will prompt you to proceed with the task for each client. Click **Yes** to proceed. A second dialog will confirm the IP address of the server to set, and again, click **Yes** to continue.

3. Each thin client listing has an indicator icon. This icon will change in the following sequence when taking ownership.
Note: To display a legend of all Indicator icon designations, select **Indicator Key** from the **View** menu item.

G. Managing Clients by Groups

The **XTC Monitor** eases the administration of multiple thin clients via logical groups. These groups can be named accordingly to suit their role or the administrator’s needs. Individual or multiple thin clients are added to groups manually or automatically by specifying an IP address range.
1. Creating a Group

Click the button on the toolbar, which will display the following dialog. Specify the group name and a description if desired. If the IP range check box is not selected an empty group is created. Check the box for IP range, and enter a start and end IP address to specify a range from which to populate the group. Click OK.

As below, the client with address 172.16.6.97 is within the specified range and therefore has been automatically added to the Development group.
2. Adding Client(s) to Groups

Whether a group was created with or without an IP range, individual or multiple thin clients can be manually added to the group. Select an individual or multiple thin clients by holding the **Ctrl** key and left-clicking on additional clients.

Click the toolbar button or right-click on a selected client and click on **Move to Group** to display a list of available groups. Select the group name of which to add the selected client(s). (NOTE: Clients are added to a group and displayed under that group, but all clients will still be displayed in the general view including group information. Additionally, clients can only belong to one group at a time.)
3. Moving and/or Removing Client(s) from Groups

Select an individual or multiple clients. Click the toolbar button or right-click on a selected client, and click on the Move to Group item to display available groups. Click on a different group name to which to move the client or select Remove out of group(s) to disassociate the client(s) from the current group.

4. Available Group Management Functions

When right-clicking on a group, a context menu appears listing the available tasks that can be performed on the whole group. The task is queued for each client within and ran one after the other until all have finished. The available tasks do not include all tasks that can be performed on individual clients.
H. System Management Functions

**XTC Monitor** provides various thin client system control and management features. These capabilities include remote power on and off, reboot, remote control, update patches, and factory image restoration.

**Note:** Available only when the thin client is detected as running. Select this item to shutdown the thin client.
1. Power Off

Available only when the thin client is detected as running. Select this item to shut-down the thin client.

![Image of system management menu]

2. Power On

Available only when the thin client is detected as being off. Select this item to remotely power on the thin client via a broadcasted “Wake-On-LAN” UDP network packet. (This feature will only work with thin clients connected to the same physical LAN as the management server.)

3. Reboot

Reboots thin clients currently running in Windows XPe

4. Shadow Unit

Launches VNC viewer to remotely control currently running thin client.

5. Manage Patches

Provides a means to update XTC Agent and TCP/IP Emulator specific files. Selecting this task launches the **Update-files Organizer.**
a. Click the **Select** button to browse for the updated files. Choose a single or multiple files using the **Ctrl-click** sequence, and then click **Open** to add the files.

b. The newly added files will appear in the **New** list on the left side of the **Update-files Organizer** dialog. Once you are certain of your selection, click the **Add** button to copy the files into the update repository and configure them for
updating the thin clients. The file names will then appear in the Current list on the right side as follows.

c. By default, all update files will be sent to the installed path of the XTC Agent on the thin client. Each file can be configured to be placed in any path on the thin client by selecting the file in Current list and clicking the Move to button. The following dialog appears.
d. Select the desired path from the list and click the **Move there** button to configure the destination for the specified file. A few paths will be predefined, which are relative to that **XTC Agent** installed location. However, custom paths can be added by entering the location into the text box next to the **Create New** button. To specify a destination relative to the root of the C drive, use “CROOT” instead of “C:”. For example, if “C:\SOMEFOLDER” is the destination, the path to enter would be “CROOT\SOMEFOLDER” as pictured above. Likewise, “DROOT” would replace “D:". Click the **Create New** button to add the path to list of configured paths. These paths will appear in the list box preceded by “\Updates\”, which denotes the repository folder, followed by the new path.

e. **Push Patches**

This task pushes all files that have been configured with the **Manage Patches** task to the selected thin client(s).

f. **Restore Factory Image**

This task permits the administrator to restore a factory image to the selected thin client. These factory images are generally provided on CD/DVD from 10ZiG.

1. When clicking on this task for a selected thin client, the following warning dialog will appear describing the sequence of events that will occur. Click the **OK** button to proceed.

```
What Are You

ATTENTION!
You have chosen to perform the Update Product task on Thin Client 172.16.6.97.

This task includes 3 steps:
1. Rebooting Linux.
2. Transferring the new firmware's image file to the Client.
3. Rebooting Windows XPE.

Click OK to start this task.

WARNING! After this task's completion, all your current settings will be lost!
```

2. The **Update Product** dialog is displayed as follows. An “AUTORUN” file will be sent to the thin client and then rebooted. During the transfer of
the "AUTORUN" file, the indicator is blue.Month. The indicator then becomes red as the thin client reboots. Once the thin client has completed booting into Linux, the indicator becomes green. The thin client is then ready to be re-imaged. Click the browse button to display a file dialog to locate the desired image.

3. Browse to the appropriate folder and select the appropriate image file to restore and click the Open button to proceed.

4. Now click the Start button to proceed with transferring the restore image to the thin client.
5. The image transfer will start, and the process will require 10-20 minutes depending on the size of the image. If the image transfer is interrupted, this would very likely render the client unbootable and require assistance from 10ZiG, Inc. tech support. **DO NOT** close this dialog until the transfer has completed.

6. Once the restoration has completed, click the **Close** button, Click **Ok** on the confirmation dialog to reboot the thin client into the newly restored factory OS image.
I. 5250 Connectivity Settings

The tasks permit the administrator to configure 5250 emulation and connectivity settings. They are as pictured below.

1. Import Client

Creates a user object in the User Configuration Manager for the currently logged on user or the local administrator account on the selected thin client(s). The users can then be configured to receive updates and emulation configurations. When importing a user, click the OK button to accept the default settings, which can later be managed in the User Manager.
2. User Configuration

Displays a summary of the various settings for the user currently logged onto the client.

3. 10ZiG Emulation Configurator

Opens the **10ZiG Emulation Configurator** for the user currently logged on to the client and displays the configuration as defined in the **User Configuration Manager**, allowing changes to be made the user’s emulation configuration.
4. 10ZiG TCP/IP Configurator

Opens the TCP/IP Configurator for the user currently logged on to the thin client displaying the configuration as defined in the User Configuration Manager.
5. Update Configuration

Use *Update Configuration* to update 10ZiG Manager related configuration for the currently logged on user of the selected client(s) from the User Configuration Manager database.

6. Save Configuration

Use *Save Configuration* to save 10ZiG Manager related configuration for the currently logged on user of the selected client(s) to the User Configuration Manager database.

J. Cloning System Configuration

*XTC Monitor* provides a utility to copy system configuration changes from a “template” thin client and deploy these changes to other individual or multiple clients. This tool takes an initial snapshot of a thin client’s registry and file system. The administrator then installs any software and/or makes system related configuration changes. A second snapshot is taken and compared to the first to obtain a difference log and repository of for any new or updated files. With this information, the changes can be deployed to other selected thin clients.
1. Clone a System Configuration

Right-click on a thin-client to use as a “template” and select **Clone System Configuration** from the **System Cloning** context menu. The **10ZiG System DiffTool Server** dialog will be launched as pictured below.
2. The Client Configuration information must be provided to setup up the client with the necessary network drive mapping to which the DiffTool will store snapshot information. Enter an appropriate name into the Configuration Name text box, which is used to create a subfolder for this specific configuration on the network drive. Provide a user name preceded by the domain name or computer name with administrative rights to the server and the password for this account. Click the Setup button to configure the mapping on the client.

NOTE: The provided account must have read/write access to the DiffTool network share on the server. If you wish to use a non-administrative account, you must adjust the share and/or NTFS permissions to allow this account read/write access to DiffTool share whose local path is C:\Program Files\BOS\10ZiG Manager\DiffTool by default.

3. Once the client has been configured for the DiffTool mapping, click First Snapshot to obtain the initial system snapshot. The snapshot process will be launched on the client. When task has completed, the progress bar will be completely filled.

NOTE: The snapshot process can take 5-15 minutes or more as it must parse the client’s Windows registry as well as the system drive’s file system. The progress bar may not change for some time, but please be patient.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>First Snapshot</td>
<td>Take an initial system snapshot</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Second Snapshot</td>
<td>Take a second snapshot, compare snapshots and build a difference log.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Click on the Log tab to verify if a task was successful. The Report tab displays a Pass/Fail summary of the various snapshot stages.
4. After the initial snapshot, the DiffTool Server dialog can be closed and any software installations or system configuration changes can be performed on the “template” thin client. If necessary, reboot the client for any changes to take affect.

5. Restart the DiffTool Server dialog if necessary. Click the Second Snapshot button to obtain the “after” snapshot and compare the two snapshots for differences. Once the second snapshot process has completed the differential package will be ready for deployment.

6. Deploying a System Configuration
7. Thin Client Write Protection

![Thin Client Write Protection Diagram]

**EWF Status**

EWF is **DISABLED** currently.
Click **ENABLE** to change the EWF status.

**NOTE:** The changes will take effect after unit's rebooting.

- [ ] Reboot it automatically
- [ ] ENABLE
- [ ] Cancel

![EWF Status Window]
INDEX

Numerics
10ZiG Emulation Configurator 32
10ZiG Manager 4
10ZiG Manager Server setting 13
10ZiG TCP/IP Configurator 33
5250 Connectivity Settings 31
A
Add button 17
Advanced tab 12
C
Cloning System Configuration 34
Computer name 8
Configuration Server service 9
Confirmation 18
Creating a Group 21
D
Default Network Adapter 15
DiffTool Server 35
E
Exit Confirmation message 18
G
Groups 20
Groups tab 17
H
Host DNS Name 12
Host entry 12
I
Import Client 31
Indicator Key 20
Installation 4
Introduction 4
IP range 21
L
Launching XTC Monitor 15
M
Manage Patches 25
Management 15
Management Functions 24
O
On-Demand 17
Ownership 18
P
port number 8
Post Setup Configuration 8
Power Off 25
Power On 25
Push Patches 28
R
Reboot 25
Refresh 18
Removing Client(s) 18
Restore Factory Image 28
S
Save Configuration 34
Settings tab 16, 17
Shadow Unit 25
Show Error/Warning messages 18
Snapshot 36
Start button 17
Start Configuration Server 10
T
temporary user database 9
Thin Client IP Address Range 16
U
Update Configuration 34
Update-files Organizer 25
User Database Configuration 10
User name option 8
W
Write Protection 38
X
XTC Monitor 10